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Moodle ADA Website Training Course 
How to navigate this course. 

At the end of each lesson, look under the Navigation menu on the right and scroll down to click on the next 
module in the course.  At the end of each section a short Quiz will be asked.  

EITS Responsibilities 

The State of Nevada, Enterprise IT Services, State Web Development Team is responsible for: 

• Making sure the State Content Management System (CMS) environment has been set up to be ADA 
compliant. 

• Provide ADA compliant smart forms 
• assist in training website editors to create compliant content using smart forms. 

HELPFUL RESOURCES: 

• ADA Compliance Roadmap 
• Remediation Guides (html, documents, audio, video & YouTube) and Accessible Letterhead 
• Ektron Procedures and iNet Tutorials (Complete Basic Training Course) 

 Website Editor Responsibilities 

Website Editors are responsible for: 

• Making board/agency letterhead ADA compliant. 
• ADA Remediation of all content and documents (doc, docx, xls, xlsx, ppt, pdf, etc.) uploaded to the 

Ektron Content Management System in their Board or Agency website. 
• Links that link to content or documents outside of your website must be ADA compliant.  If the link is to 

an application the disabled user must be able to complete the process and obtain the same result as a 
sighted user.  For example, if the link label reads 'Apply for Foodstamps' the user must be able to 
successfully complete the Foodstamp Application and apply for food stamps the same as anyone else. 

HELPFUL RESOURCES: 

• ADA Compliance Roadmap 
• Remediation Guides (html, documents, audio, video & YouTube) and Accessible Letterhead 
• Ektron Procedures and iNet Tutorials (Complete Basic Training Course) 

 

 

  

http://ada.nv.gov/
http://adanew.staging.nv.gov/Resources/Remediation_Guides/
http://it.nv.gov/web
http://ada.nv.gov/
http://adanew.staging.nv.gov/Resources/Remediation_Guides/
http://it.nv.gov/web
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Overview Lesson  

DISABILITIES AND BARRIERS 

Often when people think about website accessibility, the emphasis tends to be on making websites accessible 
for non-sighted users. Though this is important, there are many different types of disabilities. 

This tutorial will briefly define what a disability is as defined by ADA and provide examples of the web 
accessibility barriers to consider while implementing website accessibility.  

DISABILITY DEFINED  

The American with Disabilities Act defines a disability as “a physical or mental impairment that 
substantially limits one or more of the major life activities of such individual; a record of such an 
impairment; or being regarded as having such an impairment.”  

As mentioned in earlier videos, the United States Access Board works to ensure that accessibility 
barriers are removed.  

Curb ramps at intersections, elevator buttons in braille, and close parking spaces are just a few 
examples of removing or diminishing physical barriers from the everyday life of those with disabilities. 

TYPES OF DISABILITIES INCLUDE 

Blind, low vision, color-blind, deaf, deafblind, motor disabilities, speech disabilities, cognitive 
disabilities, reading disabilities, seizures, and individuals who have multiple disabilities. 

EXAMPLES OF DIGITAL BARRIERS 

Like barriers in the physical world, there are many digital barriers that affect the way people with 
disabilities access websites. We will briefly cover a few examples of disabilities and barriers that need 
to be accounted for while meeting accessible design standards: 

• Physically impaired who do not have use of their hands may need to use speech 
recognition to navigate the website.  

• Blind individuals may need to use screen readers and other assistive technology to convert 
visual information into speech.  

• Visually impaired individuals who can see text may require the ability to zoom in without 
losing resolution or may need higher contrast between text and backgrounds on the 
website. 

• Hearing impaired individuals may need subtitles or transcripts for multimedia like audio and 
video that is included as part of the website.  

• Cognitively impaired individuals may not be able to read and/or retain fast enough for 
content that times out or advances too quickly.  

• Elements including images that contain rapidly flashing content (content which flashes 
three times a second or more) may trigger epileptic seizures in individuals with 
photosensitive epilepsy. 
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Overview Lesson  

ADA AND SECTION 508 
THE TWO ACTS 

The two acts that have the most impact on website accessibility are the American with Disabilities Act 
of 1990, and the Rehabilitation Act of 1973 

• The American’s with Disabilities Act is abbreviated as ADA. 
•  The 1998 amendment to the 1973 Rehabilitation is most commonly referred to as Section 

508.  

It should be noted that "ADA", "Section 508" and "W.C.A.G. 2.0 " are often used interchangeably in 
training materials when referring to website accessibility and compliance. 

THE AMERICANS WITH DISABILITIES ACT (ADA) 

The Americans with Disabilities Act (ADA) was signed into law on July 26, 1990.  

It is one of America's most comprehensive pieces of civil rights legislation that prohibits 
discrimination.  

The ADA guarantees that people with disabilities can do the following:  

• enjoy employment opportunities 
• purchase goods and services 
• participate in State and local government programs and services. 

Additional Resources: Americans with Disabilities Act 

REHABILITATION ACT OF 1973 - SECTION 508 

In 1998, Congress Amended the Rehabilitation Act of 1973, which requires Federal agencies to make 
their electronic and information technology (EIT) accessible to people with disabilities.  

It applies to all Federal agencies when they develop, procure, maintain or use electronic and 
information technology.  

Under Section 508, agencies must give disabled employees and members of the public access to 
information that is comparable to access available to others.  

Additional Resources:  Section 508 of the 1973 Rehabilitation Act 

 

  

http://www.ada.gov/
http://www.ada.gov/
http://www.section508.gov/
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Overview Lesson  

U.S. ACCESS BOARD, DEPARTMENT OF JUSTICE AND WORLD WIDE WEB 
CONSORTIUM  

There are two Federal Agencies that play a major role in accessibility. These are: 

• the United States Access Board, and 

• the United States Department of Justice.  

The World Wide Web Consortium or (W3C) is the private organization that is largely responsible for 
developing website accessibility standards.  

These three groups each play roles in the creation, adoption and/or enforcement of website accessibility 
standards.  
 

U.S. DEPARTMENT OF JUSTICE (abbreviated U.S. DOJ or DOJ) 

The Civil Rights Division of the Department of Justice, created in 1957 by the enactment of the Civil 
Rights Act of 1957, works to uphold the civil and constitutional rights of all Americans, particularly 
some of the most vulnerable members of our society. The Division enforces federal statutes 
prohibiting discrimination on the basis of race, color, sex, disability, religion, familial status and 
national origin. The Disability Rights Section of the DOJ Civil Rights Division works to achieve equal 
opportunity for people with disabilities in the United States by implementing the Americans with 
Disabilities Act (ADA).  

Additional Resources:  Civil Rights Division of U.S. Department of Justice 
 

U.S. ACCESS BOARD 

The U.S. Access Board is a federal agency that promotes equality for people with disabilities through 
leadership in accessible design and the development of accessibility guidelines and standards for the 
built environment, transportation, communication, medical diagnostic equipment, and information 
technology.  

Additional Resources: U.S. Access Board 
 

WORLD WIDE WEB CONSORTIUM 

The World Wide Web Consortium (W3C) is an international community where Member organizations, 
a full-time staff, and the public work together to develop Web standards. W3C’s Web Accessibility 
Initiative (WAI) develops strategies, guidelines, and resources to help make the Web accessible to 
people with disabilities, including their latest standards Web Content Accessibility Guidelines 2.0 
(WCAG 2.0).  

Additional Resources:WC3’s Web Accessibility Initiative 

  

http://www.ada.gov/
https://www.justice.gov/crt/disability-rights-section
http://www.ada.gov/
https://www.access-board.gov/
http://www.ada.gov/
https://www.w3.org/WAI
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Overview Lesson  

REASONS TO BE ADA & SECTION 508 COMPLIANT.  

This section looks at three important reasons to design State of Nevada websites to be ADA, Section 
508 and W.C.A.G. 2.0 compliant: social factors, technical factors and legal factors for website 
accessibility.  

SOCIAL FACTORS 

Creating a website using accessible design ensures that as many people as possible have access to 
State of Nevada resources and services.  

Accessible design benefits those with disabilities as well as many people who do not have 
disabilities.  

Others who benefit from websites that meet accessible design standards are older people, people 
with low literacy and people struggling with language fluency.  

Additional Resources: Social Factors in Accessible Design 

TECHNICAL FACTORS 

Websites designed to meet accessibility standards are better for technical reasons including the 
following examples:  

• Search engines are better at directing people to the right resources on accessible sites.  
• Accessible websites make using websites easier for users with low bandwidth connections and 

people using older technologies.  
• Accessible websites allow organizations to be prepared for future changes to technology and 

accessibility standards. 

More information about Technical Factors in accessible design can be found at 
http://www.w3.org/wai/bcase/tech.  

LEGAL FACTORS 

On January 18, 2017 the United States Access Board approved a rule change that included adoption 
of W3C WCAG 2.0 Standards.  

The United States Access Board adopts accessibility standards for federal entities as well as entities 
that accept federal funding.  

The United States Department of Justice is currently requiring state entities that receive federal funds 
to have accessible websites.  

The U.S. Department of Justice is looking at requiring state governments to have accessible websites 
whether they receive federal funds or not.  

http://www.w3.org/wai/bcase/soc
http://www.w3.org/wai/bcase/tech
https://access-board.gov/guidelines-and-standards
https://access-board.gov/guidelines-and-standards
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Overview Lesson  

Congratulations - end of lesson reached 

Helpful Resources for This Topic 

  

http://ada.nv.gov/Resources/Course-Resources/
https://nvelearn.nv.gov/moodle/help.php?component=lesson&identifier=overview&lang=en
https://nvelearn.nv.gov/moodle/help.php?component=lesson&identifier=overview&lang=en
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Remove/Delete It or Remediate it! 
As you may recall from the overview course, On January 18, 2017 the United States Access Board approved a rule 

change that included adoption of W3C WCAG 2.0 Standards, and the United States Department of Justice (DOJ) is 

currently requiring state entities that receive federal funds to have accessible websites. The DOJ is considering imposing 

a broad requirement on state governments to have accessible websites whether they receive federal funds or not. 

These changes affect all web related content and digital media and includes all of the content on your web pages, 

documents (Word, PDF, Excel and more), audio and video files within your site or to which you link. There is no 

exemption for documents, pages or media that were posted before the rule changes went into effect.  

Accordingly, it is important for State of Nevada content management system (currently Ektron) editors to remove 

outdated content, documents, audio and video files from their websites. Any content, documents, audio or video files 

that are not removed will need to be remediated by the site’s content editors to meet accessibility requirements. 

Websites should not be used to archive web content, documents, audio or video files. 

Congratulations - end of lesson reached 

Siteimprove Accessibility Tools 

The Siteimprove Content & Accessibility Monitoring Tool and the Siteimprove Accessibility Checker 
Tool for the Chrome Browser both use Web Content Accessibility Guidelines (WCAG 2.0) as their 
guides.  They offer a paid monitoring tool that will monitor a website and identify accessibility issues 
in content as well as pdf documents.  In addition, Siteimprove offers an extension for the Chrome 
Browser that can be used on any website and works behind the state firewall that is free to everyone. 

• Install the Siteimprove Accessibility Checker Tool for the Chrome Browser 
• Using the Siteimprove Accessibility Checker Evaluation Tool for the Chrome Browser 

The paid Siteimprove monitoring tool checks every page in a website for accessibility issues while the 

Siteimprove Accessibility Evaluation Tool for the Chrome Browser only checks a single web page at a 

time and can only be used in the Chrome browser. Please be aware that there are disability barriers 

that an electronic tool cannot identify.  A user must manually view sites for these barriers.   

• Website Accessibility Manual Review Checklist (docx) 

 

Helpful Resources 

 

  

http://ada.nv.gov/uploadedFiles/adanewnvgov/content/Users/InstallingSiteimproveChromeExtension.docx
http://ada.nv.gov/uploadedFiles/adanewnvgov/content/Users/UsingSiteimproveAccessibilityChecker.docx
http://ada.nv.gov/uploadedFiles/adanewnvgov/content/Users/WebsiteAccessibilityManualReviewChecklist_ADA.docx
http://ada.nv.gov/Resources/Course-Resources/
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Remediating Content 
Two of the most common barriers to accessibility are the lack of meaningful Alternative Text for images and ambiguous 

link labels. 

ALTERNATIVE TEXT SHOULD BE MEANINGFUL:  One of the simplest things website editors can do to aid 

accessibility is by entering meaningful Alternative text for each image they upload to the system.   Alternative 

text provides a textual alternative to non-text content in web pages.  When determining appropriate alternative 

text for images, context is everything. The alternative text for one image may be vastly different based upon the 

context and surroundings of the image itself.  The first step when determining appropriate alternative text for an 

image is to decide if the image presents content and if the image has a function.  

Typically, Alternative Text should: 

1. Be accurate and equivalent in presenting the same content and function of the image. 

2. Be succinct.  This means the correct content (if there is content) and function (If here is a function) of the image 

should be presented as succinctly as is appropriate.  Typically, no more than a few words are necessary, though 

rarely a short sentence or two may be appropriate.   

3. NOT be redundant or provide the same information as text within the context of the image. 

4. NOT use the phrases "image of...", or "graphic of...." to describe the image.  It is usually apparent to the user 

that it is an image.  And if the image is conveying content, it is typically not necessary that the user know that it 

is an image that is conveying the content, as opposed to text.  If the fact that an image is a photograph or 

illustration, etc. is important content, it may be useful to include this in alternative text. 

HOW TO WRITE MEANINGFUL LINK TEXT 
Avoid uninformative link phrases. Links are more useful when they make sense out of context.  
Editors should avoid non-informative link phrases such as: click here, here, more, read more, link to 
[some link destination], info, for more information [some link destination], etc.   

In most cases, links should be words or phrases. In some instances, though, it may make sense to 
link a single character, letter of the alphabet, or numeral as long as you make sure the link is large 
enough to be clickable on touch devices and for users with motor or other disabilities.  

Links should never be empty.  They must always contain text or images with alternative text.  An 

empty link can be navigated to but does not present any content.  This can be very confusing for 

keyboard and screen reader users. 

Link labels should make sense out of context.  Link labels should make sense out of context.  

Screen readers read out to disabled users links on the page so each link needs to make sense when 

read without any other surrounding text to make it make sense.  Answer this question:  Can you paste 

the link label into a word or excel document and does it make sense and tell you where the link would 

take you? If not, relabel the link. 

Link text used for multiple destinations – The same link text is used for links going to different 

destinations.  Users might not know the difference if they are not somehow explained.  If the 

destination is the same, this is not an issue.  If the destination pages are NOT the same, re-label the 

links so they can be distinguished by their link texts.  All links throughout your website that go to the 

same destination should have the same link labels. 
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URLS as Links. URLs are not always human-readable or screen-reader friendly. Many URLs contain 

combinations of numbers, letters, ampersands, dashes, underscores, and other characters that make 

sense to scripts and databases but which make little or no sense to the average person. In most 

cases, it is better to use human-readable text instead of the URL. 

The human readable link Constructing Accessible Web Sites is more user-friendly than the link to 

purchase the book by the same title on Amazon.com, which consists of a 108-character link full of 

numbers, slashes, and text that is not very human-readable. 

(http://www.amazon.com/exec/obidos/ASIN/1590591488/qid=1116957951/sr=2-

1/ref=pd_bbs_b_2_1/103-5755258-8204633 ) 

Does this mean that URLs should never be used as links? No. If the URL is relatively short (such as a 

site's homepage), the URL may be used as the link text. The key is to be considerate of screen 

reader users who must listen to the longer, less intelligible URLs. 

Links should look like links – links should be easily identifiable and nothing else should look like a 

link.  Users are accustomed to seeing links underlined. In body text, they may or may not be able to 

figure out which text is linked if the underline convention is not used.  

Links should be large enough – links should be large enough to enable users with motor disabilities 

and users of mobile devices to click on the link.  In rare instances, though, it may make sense to link 

a single character, letter of the alphabet, or numeral. 

HELPFUL RESOURCES: 

We recommend printing the following items: 

• A printable Alternative Text Remediation Guide is available on the ADA website. 
• Metadata: What is is and How it Works 
• Ektron Template Masters (Wireframes) 

  

http://www.amazon.com/exec/obidos/ASIN/1590591488/qid=1116957951/sr=2-1/ref=pd_bbs_b_2_1/103-5755258-8204633
http://www.amazon.com/exec/obidos/ASIN/1590591488/qid=1116957951/sr=2-1/ref=pd_bbs_b_2_1/103-5755258-8204633
http://www.amazon.com/exec/obidos/ASIN/1590591488/qid=1116957951/sr=2-1/ref=pd_bbs_b_2_1/103-5755258-8204633
http://ada.nv.gov/Resources/HTMLdoc/
http://it.nv.gov/uploadedFiles/IT.nv.gov/Content/Sections/Application_Development/Web/How%20Metadata%20works.pdf
http://it.nv.gov/uploadedFiles/IT.nv.gov/Content/Sections/Application_Development/Web/MasterTemplates.pdf
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Remediating Content  

ADA SLIDES” SMART FORM 

1) The information contained within this document guides users on how to use the “ADA Slides” 
Smart Form.  
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Remediating Content  

SMART FORM - ADA SLIDES 
Content Block “Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.  
2. This title will become part of the URL for this “ADA Slide” Smart Form so the name used should be as 

short as possible.  Spaces and special characters other than an underscore (_) or a dash (-) are best 
avoided. 

3. Once set, if you change this content block “Title” field all links to the "ADA Slide” Smart Form will break. 
DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA SLIDES 
“Slides Configuration” Selections 

1. Style – This configuration selection allows you to select one of three options: 
1) large slide 900 pixels wide,  
2) small slide 580 pixels wide in a white border 
3) small slide 580 pixels wide with no border 

2. Paging – This feature should not be used as it is not ADA Compliant.  It places a button for each slide 
on the bottom, to the left or right or both, depending on what the user selects. 

3. Cross Fade – This configuration selection will allow you to select a cross fade effect for the slides.  

4. Effect – This configuration selection will allow you to select to have the slide fade away or slide 

into and out of view.  
5. Caption – This configuration allows the user to add a caption to be included as part of the slide. To use 

this feature, enter text in the description field for each slide. 
6. Rotate – This configuration allows the user to choose to rotate the slides.   
7. Randomize – This configuration allows the user to rotate the slides in a random order.  
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Remediating Content  

SMART FORM - ADA SLIDES 
 “Slides” Text Areas 

1. Title – This area is for the title of the slide. The title attribute, by definition, can be used to provide 

advisory information. It should:  

1) NOT provide vital information or information necessary for accessibility. 
2) NOT provide the same information as is available in text or alternative text. 
3) NOT present the obvious. If the advisory title does not provide additional, useful 

information, it can be removed. 
4) NOT be used as a replacement for alternative text, form labels, table headers, etc. 

2. Alternative Text – This alternative text field is incredibly important in order to meet accessibility 
standards as this is the field assistive technologies read to disabled users. A brief description of what 
the image represents is placed in this field unless the image is also a link, in which case, the alternative 
text must describe the function of the link 

3. Description – This is the black box with white text that appears at the bottom of each slide if you have 
captions turned on.  This allows you to provide a description for each slide image.  If captioning is 
turned off, this text will not display. 

4. Photo Courtesy of (optional) – This field is optional and can be used to give credit to a photographer, 
if applicable.  
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Remediating Content  

SMART FORM - ADA SLIDES 
 “Slides” Link Area 

1. Link (make image linkable, optional) – This section allows you to link the slide image to another page, 
document or website. If the URL field is used the Alternative Text should describe the function of the 
link.  When naming the link, remember the rules discussed at the beginning of the Remediating Content 
section for link labels: 

1) Avoid non-informative link labels 
2) Link labels should never be empty 
3) Link labels should make sense out of context 
4) The same link labels should not be used for multiple destinations. 
5) URLs can be used as links when the URL is relatively short and is easily readable by humans.  

Otherwise it is best to embed all URLs in text easily read by humans. 
6) Links should look like links – be underlined or have some other visible way to indicate to users it 

is a link. 
7) Be large enough to enable users with motor disabilities or who use touch devices to activate 

them. 
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Remediating Content  

SMART FORM - ADA SLIDES 
 “Slides” YouTube ID 

1. YouTube ID – This allows you to include a YouTube video as a slide.  

 

2. Copy the ID of the YouTube address after the equal (=) sign and enter it in the YouTube field shown 
above to display a YouTube Video as a slide.  Note:  If using the YouTube video slide, it should be the 
ONLY slide in the ADA Slide Smart Form and the selection for Rotate and Random should be set to 
No.  Otherwise you will continue to hear the video when the slide rotation moves to another image. 

 

 

  



Revised 12/18/2018 
 

Remediating Content  

SMART FORM - ADA SLIDES 
“Slides” Image 

1. Image – This is the section used to add a slide image.  When uploading an image, be sure that the 
Alternative Text field has meaningful text in it describing the image or the function of the image. 
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Remediating Content  

SMART FORM - ADA SLIDES 
 “+Slide” 

1. +Slide – clicking the “+Slide” allows you to add an additional slide area.  

 

End of Lesson 
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Remediating Content  

SMART FORM - ADA CAROUSEL  
“ADA Carousel” Smart Form 

1. The information contained within this document guides users on how to use the “ADA 
Carousel” Smart Form.  
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Remediating Content  

SMART FORM - ADA CAROUSEL 
“Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.  
2. This title will become part of the URL for this “ADA Carousel” Smart Form so the name used should be 

as short as possible.  Spaces and special characters other than an underscore (_) or a dash (-) are 
best avoided. 

3. Once set, if you change this content block “Title” field all links to the "ADA Carousel” Smart Form will 
break. DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA CAROUSEL 
“Carousel Configuration” Selections 

1. Style – This configuration selection allows you to select whether the carousel will be Home Page Full, 
Secondary Page Full or Secondary Page Half.   

2. Rotate – This configuration allows the user to select if there will be a rotation of carousel images.  Note: 
Typically, this configuration is only used when there are more carousel images than can be displayed 
on the page without rotation. 
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Remediating Content  

SMART FORM - ADA CAROUSEL 
“Carousel” Title Areas 

1. Title – This area is for the Category Title.   It will place a level 2 heading directly above the entire 
carousel. 
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Remediating Content  

SMART FORM - ADA CAROUSEL  
“Carousel Image Title, Alternative Text and Image” 

1. Title - This title will not be displayed on the page.  The title attribute, by definition, can be used to 
provide advisory information. It should: 

• NOT provide vital information or information necessary for accessibility. 

• NOT provide the same information as is available in text or alternative text. 

• NOT present the obvious. If the advisory title does not provide additional, useful 
information, it can be removed. 

• NOT be used as a replacement for alternative text, form labels, table headers, etc. 
2. Alternative Text – This alternative text field is incredibly important to meet W.C.A.G. 2.0 success 

criteria as this is the field assistive technologies read to disabled users. A brief description of what the 
image represents is placed in this field unless the image is also a link, in which case, the alternative text 
must describe the function of the link.  Ex: where we used the generic 'red sweater' for the image in the 
title field example above, in this field we would expand upon the description... Men's long-sleeved red 
sweater, unless the image had a function, then we would describe the function. 

3. Image – This is the section used to add a Carousel image.  Note:  When uploading images to the 
system be sure to fill in the Alt Text field to meet accessibility standards. 
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Remediating Content  

SMART FORM - ADA CAROUSEL 
"+Item" 

1. +Item – Allows you to add an additional Carousel image section to the smart form. 
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Revised 12/18/2018 
 

Remediating Content  

SMART FORM - ADA IMAGE ONLY 
“ADA Image Only” Smart Form  

1. The information contained within this document guides users on how to use the “ADA 
Image Only” Smart Form.  
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Remediating Content  

SMART FORM - ADA IMAGE ONLY 
 “Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.  

2. This content block title will become part of the URL for this “ADA Slides” Smart Form so 
the name used should be as short as possible.  Spaces and special characters other than 
an underscore (_) or a dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to the "ADA Carousel” 
Smart Form will break. DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA IMAGE ONLY 
 “Image” Field 

1. Image icon – click the image icon to add a single image to the “ADA Image Only” smart 
form.  

Note:  the title used when uploading the image becomes the alternative text for the image.  Make 
sure the alternative text is meaningful or upload a new image and give it meaningful alternative 
text. 
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“ADA Initiative Boxes” Smart Form 

1. The information contained within this document guides users on how to use the “ADA 
Initiative Boxes” Smart Form.  
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.  
2. This content block title will become part of the URL for this “ADA Initiative Boxes” Smart Form so the 

name used should be as short as possible.  Spaces and special characters other than an underscore 
(_) or a dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to the " ADA Initiative Boxes” Smart 
Form will break. DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“ADA Initiative Boxes Configuration” Style 

1. Style – This configuration selection allows you to select whether the Initiative Boxes will be 

displayed horizontally or vertically.  Choose Style 1 to display the initiative boxes horizontally across 

the page and Style 2 to display them vertically.   
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“Initiative Items: Top Title, Sub Title, Title and Alt Text ” Fields 

1. Top Title –This field is used for the top title of the initiative box.  This is the first title 
appearing on the gray background directly above each initiative box.  
1) Style 1 displays black text in normal casing style on a gray background. 
2) Style 2 displays black text in normal casing with a bullet on a white background. 

2. Sub Title – This field is used for the sub title of the initiative box. This is the second title 
appearing on the gray background directly above each initiative box. 
1) Style 1 displays the text in all capital black letters on a gray background.  The lettering is 
larger than that used for the Top Title in Style 1. 
2) Style 2 displays black text in normal casing style on a white background. 

3. Title –  This field is the title of the initiative box. The title attribute, by definition, can be used 
to provide advisory information. It should: 

• NOT provide vital information or information necessary for accessibility. 

• NOT provide the same information as is available in text or alternative text. 

• NOT present the obvious. If the advisory title does not provide additional, useful 
information, it can be removed. 

• NOT be used as a replacement for alternative text, form labels, table headers, etc. 
4. Alt Text – This alternative text field is incredibly important to meet accessibility success 

criteria as this is the field assistive technologies read to disabled users. A brief description 
of what the image represents is placed in this field unless the image is also a link, in which 
case, the alternative text must describe the function of the link.  
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“Initiative Items: Image & URL” Fields  

1. Image – This image icon is clicked to select an existing image or to add a new image to the Initiative item 

section. If an image is used make sure the Alt Text field has been filled in with meaningful alternative text. 

2. URL – This field is selected if the Initiative Item image is going to link to content or documents.  

Remember link rules discussed at the beginning of Remediating Content when creating link labels. 
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
“Initiative Item: Description” Field 

1. Description – This field will display text directly under the initiative box and is typically a description of 

the items linked under this image. 
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
Links 

1. Link Title – The link title is the text label displayed for link that you create.  Remember the rules 
for creating link labels provided under the Remediating Content section when labeling links to 
ensure they meet accessibility standards. 

2. Link URL – The Link URL field is used to hyperlink the link to a destination (i.e, document, 
webpage or another website).  Note:  If an image is used be sure the Alt Text field has been filled 
in with meaningful text. 
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Remediating Content  

SMART FORM - ADA INITIATIVE BOXES 
+Link/+Item 

1. +Link - Allows you to add an additional Link under an initiative item. 
2. +Item – Allows you to add an additional Initiative Box section. 
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Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
“ADA Social Media” Smart Form  

1. The information contained within this document guides users on how to use the “ADA Social Media” 

Smart Form.  
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Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
 “Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.  
2. This title will become part of the URL for this “ADA Social Media” Smart Form so the name used should 

be as short as possible.  Spaces and special characters other than an underscore (_) or a dash (-) are 
best avoided. 

3. Once set, if you change this “Title” field all links to the " ADA Social Media” Smart Form will break. DO 
NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
“ADA Social Media Category” Title Area 
1. Title – This will add a category title (a level two heading) above all the social media icons you choose to 

display.

 

  



Revised 12/18/2018 
 

 

Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
“ADA Social Media Style” Selections  

1. Style – This configuration selection can be ignored as there are no differences between Style 1 and 

Style 2. 
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Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
“Social Media” Fields 

1. Social Media Title – This is the title field for the social media item.  The title attribute, by definition, can 
be used to provide advisory information. It should:  

• NOT provide vital information or information necessary for accessibility. 

• NOT provide the same information as is available in text or alternative text. 

• NOT present the obvious. If the advisory title does not provide additional, useful information, it can 
be removed. 

• NOT be used as a replacement for alternative text, form labels, table headers, etc. 
2. Alternative Text – This alternative text field is incredibly important to meet accessibility success criteria 

as this is the field assistive technologies read to disabled users. A brief description of what the image 
represents is placed in this field unless the image is also a link, in which case, the alternative text must 
describe the function of the link. 

3. Drop Down Menu – Select the icon you wish to display Twitter, Facebook, YouTube, Flickr, Google+, 
Linkedin, Blog, Email, or SubscribeEmail.  

4. URL – used to link the Twitter Icon to a twitter feed, document, page or another website.   
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Remediating Content  

SMART FORM - ADA SOCIAL MEDIA 
+Item 

1. +Item – Allows you to add additional Social Media sections.  You can have multiple icons that will 
be horizontally displayed. 
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Remediating Content  

SMART FORM - ADA PAGE PROGRAM 
“ADA Page Program” Smart Form  

1. The information contained within this document guides users on how to use the “ADA Page 
Program” Smart Form. 
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SMART FORM - ADA PAGE PROGRAM 
“Title” Field 

1. The first section of the smart form that you will fill out is the content block Title field.   
2. This content block Title field will become part of the URL for this “ADA Page-Program” Smart 

Form so the name used should be as short as possible.  Spaces and special characters other 
than an underscore (_) or a dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to this “ADA Page-Program” 
smart form (page) will be broken.  DO NOT CHANGE THIS NAME. 
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SMART FORM - ADA PAGE PROGRAM 
“Page Program Style and Title” Fields  

1. Style Drop Down – This can be ignored as Style 1 is the only style available and is selected by default. 
2. Page Title – This will add a visible level one heading to the Page Program smart form.  Unlike the 

content block Title, the Page Title can be changed as many times as you like without affecting the URL 
or breaking any links to this smart form. 
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SMART FORM - ADA PAGE PROGRAM 
“Content Area” Fields  
1. Paragraph Header – If you are adding a paragraph to the content area of your website, you can 

add a level 2 heading above the paragraph.  A level 2 heading should never be used before a 
level 1 heading.  Heading levels should be used in order. 

2. Paragraph Copy – The content for a paragraph, table or image can be entered in this section. 
You will be able to add more than one paragraph to this area in the editor, but we recommend 
you only add ONE paragraph per paragraph copy field and create a new paragraph for EACH 
additional paragraph to avoid spacing issues. 

3. Title – Links in the link/list section below a paragraph must be given a title.   It is the link label 
(title) users will be able to click on to activate the link. 

4. URL –  Click the URL icon to add the link and a Tooltip for the link.  The Tooltip is what screen 

readers read out to disabled users.  Do not place a website URL in this field. 
5. +link - adds another link item to the list in the smart form. 

6. +paragraph - adds another paragraph section to the smart form. 
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SMART FORM - ADA PAGE PROGRAM 
“Bottom Boxes” Fields 

1. Title – This is the title field for the social media item.  The title attribute, by definition, can be used to 
provide advisory information. It should: 

• NOT provide vital information or information necessary for accessibility. 

• NOT provide the same information as is available in text or alternative text. 

• NOT present the obvious. If the advisory title does not provide additional, useful information, it can 

be removed. 

• NOT be used as a replacement for alternative text, form labels, table headers, etc. 

2. Alt Text – If an image is used this alternative text field is incredibly important to meet accessibility 
success criteria as this is the field assistive technologies read to disabled users. A brief description of 
what the image represents is placed in this field unless the image is also a link, in which case, the 
alternative text must describe the function of the link. 

3. URL / Document – If you are selecting a document to upload or link to from the bottom box, it can be 
selected here.  

4. Image Icon – If you are selecting an image for the bottom of the ADA Program Page Smart Form, you 
will click this icon and upload a new image or select an existing image in the content management 
system.  

5. Link / List Title – Links in the link/list section below a paragraph can be given a title.  
6. Link / List URL / Documents – Click the URL icon to add the link and alternative text for the link. 
7. +link - adds a link item to the list. 
8. +bottom - adds an additional bottom boxes item to the smart form. 
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SMART FORM - ADA PAGE PROGRAM 
“Right Column” Fields 

1. Header Title – This field displays a level 2 heading above any contact information or any other 

content you want to place in Right Column.   

2. Name – This field is used for the name of the person or entity to contact.  

3. Title – This field is used to include the title of the person to contact.   

4. Phone – This field is used to include the phone number for the person or entity to contact.   

5. Email – This field is used to include the email address for the person or entity to contact.  
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SMART FORM - ADA PAGE PROGRAM 
“Right Column Links” Fields 

1. Group –  Displays a level 2 heading above a group of links.  

2. Link / List Item Title – Links in the link/list item section must be given a title to provide the user a way to activate the 

link.  Remember the rules provided in the Remediating Content section when creating the link label title.  

3. Link / List Item Alt Text –  If an image is used this alternative text field is incredibly important to meet accessibility 

success criteria as this is the field assistive technologies read to disabled users. A brief description of what the image 

represents is placed in this field unless the image is also a link, in which case, the alternative text must describe the 

function of the link. 

4. Link / List Item URL / Document – Adds a link to a document, image, web page or another website. 

5. Link / List Item Image Icon – Adds an image to the smart form.  Click this icon to upload a new image to display on 

the page or to select an existing image to display that has previously been uploaded to the content management 

system. 

6. Link / List Item +link – adds another link to the Link / List Item section. 

7. Link / List +link – adds another Link / List Group to the smart form. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
 “ADA State: Page-Program V4” Smart Form  

1. The information contained within this document guides users on how to use the “ADA State: 
Page-Program V4” Smart Form. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
 Content Block “Title” Field 

1. The first section of the smart form that you will fill out is the Title field.   

2. This content block title field will become part of the URL for this “ADA State: Page Program V4” 

Smart Form so the name used should be as short as possible.  Spaces and special characters 
other than an underscore (_) or a dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to this "ADA State: Page 

Program V4" smart form (page) will be broken.  DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
 “ADA State: Page-Program V4” Style and Title Areas   

1. Style Drop Down – This can be ignored as Style 1 is the only style available and is selected by default. 
2. Page Title – This will add a visible level one heading to the Page Program smart form.  Unlike the 

content block Title, the Page Title can be changed without affecting the URL of this smart form. Every 
page should have a level one heading. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
 “Content Area Including Link / List” Fields   
1. Paragraph Header – If you are adding a paragraph to the content area of your website, you can 

add a level 2 heading above the paragraph.  A level 2 heading should never be used before a 
level 1 heading.  Heading levels should be used in order. 

2. Paragraph Copy – The content for a paragraph, table or image can be entered in this section. 
You will be able to add more than one paragraph to this area in the editor, but we recommend 
you only add ONE paragraph per paragraph copy section and create a new paragraph for EACH 
additional paragraph to avoid spacing issues.  

3. Link / List Title – Links in the link/list section below a paragraph must be given a title.   It is the 
link label users will be able to click on to activate the link. 

4. Link / List Alt Text – If an image is used this alternative text field is incredibly important to meet 
accessibility success criteria as this is the field assistive technologies read to disabled users. A 
brief description of what the image represents is placed in this field unless the image is also a 
link, in which case, the alternative text must describe the function of the link. 

5. Link / List URL –  Click the URL icon to add the link and a Tooltip for the link.  The Tooltip is 

what screen readers read out to disabled users.  Do not place a website URL in this field. 

6. Link / List Image Icon - Adds an image to the smart form.  Click this icon to upload a new image 

to display on the page or to select an existing image to display that has previously been uploaded 

to the content management system. 

7. Link / List YouTube – This allows you to include a YouTube video in your page. Copy the ID of 

the YouTube address after the equal (=) sign and enter it in the YouTube field. 

8. Link / List YouTube Size – Choose Medium (Two col page) for a larger embedded video and 

Small (three col page) for a smaller embedded video. 

9. Link / List Display Bullet – Check to display a bullet in front of the Link / List item or uncheck 

the checkbox so a bullet is not displayed. 

10. +link – Allows you to add another Link / List item. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
“Content Area – Sub-Link / List” Fields  
1. Title – Links in the link/list section below a paragraph must be given a title.   It is the link label 

users will be able to click on to activate the link. 
2. Alt Text – If an image is used this alternative text field is incredibly important to meet accessibility 

success criteria as this is the field assistive technologies read to disabled users. A brief 
description of what the image represents is placed in this field unless the image is also a link, in 
which case, the alternative text must describe the function of the link. 

3. Display Bullet – Check to display a bullet in front of the Sub Link / List item or uncheck the 
checkbox so a bullet is not displayed. 

4. +sublink – Allows you to add another Sub Link / List field. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
“Right Column” Fields 
1. Paragraph Header – Adds a level 2 heading above the paragraph.  A level 2 heading should 

never be used before a level 1 heading.  Heading levels should be used in order. 
2. Paragraph Copy – The content for a paragraph, table or image can be entered in this section. 

You will be able to add more than one paragraph to this area in the editor, but we recommend 
you only add ONE paragraph per paragraph copy field and create a new paragraph copy field for 
EACH additional paragraph to avoid spacing issues.  

3. Link / List Title – Links in the link/list section below a paragraph must be given a title.   It is this 
link label users will be able to click on to activate the link. 

4. Link / List Line – Allows you to add a soft gray line between link items 

5. Link / List Alt Text – If an image is used this alternative text field is incredibly important to meet 
accessibility success criteria as this is the field assistive technologies read to disabled users. A brief 
description of what the image represents is placed in this field unless the image is also a link, in which 
case, the alternative text must describe the function of the link. 

6. Link / List URL –  Click the URL icon to add the link and a Tooltip for the link.  The Tooltip is 
what screen readers read out to disabled users.  Do not place a website URL in this field 

7. Link / List Image Icon –  If you are selecting an image for the bottom of the ADA Program Page 
Smart Form, you will click this icon and upload a new image or select an existing image in the 
content management system. 

8. Link / List YouTube – This allows you to embed a YouTube video. 
11. Link / List YouTube Size – Small is the only size option available. 

9. +Link – Allows you to add another Link / List field. 
10. +paragraph_right - Allows you to add another Right-Column section. 
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Remediating Content  

SMART FORM - ADA STATE: PAGE PROGRAM V4 
 “Bottom Boxes” Fields 

1. Title – This is the title field for the social media item.  The title attribute, by definition, can be used to 
provide advisory information. It should: 

• NOT provide vital information or information necessary for accessibility. 

• NOT provide the same information as is available in text or alternative text. 

• NOT present the obvious. If the advisory title does not provide additional, useful information, it can 

be removed. 

• NOT be used as a replacement for alternative text, form labels, table headers, etc. 

2. Alt Text – If an image is used this alternative text field is incredibly important to meet accessibility success 
criteria as this is the field assistive technologies read to disabled users. A brief description of what the 
image represents is placed in this field unless the image is also a link, in which case, the alternative text 
must describe the function of the link. 

3. URL / Document – If you are selecting a document to upload or link to from the bottom box, it can be 
selected here.  

4. Image Icon – If you are selecting an image for the bottom of the ADA State: Page-Program V4 Smart 
Form, click this icon to upload a new image or select an existing image previously uploaded to the content 
management system. Be sure the fill out the Alt Text field with meaningful alternative text to meet 
accessibility standards. 

5. Link / List Title – Links in the link/list section below a paragraph must be given a title to provide the user 
with a way to see and activate the link.  Remember link label rules designated at the beginning of the 
Remediating Content section when creating titles for links.  

6. Link / List URL / Documents – Click the URL icon to add the link and alternative text for the link. 
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7. +Link – Allows you to add another Link / List field. 
8. +bottom – Allows you to add another Bottom Image section. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“ADA Meetings and Agenda” Smart Form 
1. The information contained within this document guides users on how to use the  “ADA Meetings 

and Agenda” Smart Form. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Title” Field 

1. The first section of the smart form that you will fill out is the Title field.   
2. This content block Title field will become part of the URL for this “ADA Meetings and 

Agendas” Smart Form so the name used should be as short as possible.  Spaces and special 
characters other than an underscore (_) or a dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to this “ADA Meetings and 
Agendas” smart form (page) will be broken.  DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Page Title” Field 
 

1. Page Title - displays a level 1 heading at the top of the page.  All smart forms should have a level 1 

heading to meet accessibility success criteria.   This field can be changed as many times as you like 

without affecting the URL or breaking any links to the smart form. 

2. Page Style - this can be ignored as there is only Style 1 available and it is selected by default. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Page Copy” Field 
 
1. Page Copy - Information that you would like to be included above the Meeting items and Agendas can be 

included in this area. This field will accept headings, text, tables, etc. and they will be displayed directly 

under the level 1 heading. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Homepage Widget”  

Only complete this section if you want to display a widget like either of the images shown below on 
the homepage of your website in the Banner Right position.  
 
1. Home Style 1 - displays a level 2 heading on a colored background 

 
2. Home Style 2 displays a level 2 heading on a white background 

 
3. Home Style 3 displays the same thing as displayed in Style 2.  Style 3 can be ignored. 

4. Display Title (Home) – designates the text that will be displayed as a level 2 heading above the meeting 

date and time. 

5. Document Home URL –  This field is used to link to the ADA Meetings and Agendas page.  Though it 

seems like you are linking to page to itself, remember, this is actually creates the link displayed by the date 

and time in the homepage widget and these fields are NOT displayed on the ADA Meetings and Agendas 

page. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Date,” “Time,” and Meeting information Fields 
 
1. Date - select or enter the date of the meeting.  

2. Time - enter the meeting time in (HH:MM AM/PM) format.  

3. Meeting Title – Typically, this field is used to enter the name of the committee, task force or organization 

holding the meeting and/or to indicate if the meeting is an open or closed meeting. 

4. Untitled Field - enter any notes that you want to be displayed at the bottom of the meeting block.  

Typically, this is also used to indicate that an ‘Agenda will follow’ when a meeting notice is posted without 

an agenda. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Location” Fields 
 
1. Type - select whether the meeting location is a physical location, is a video conference, a teleconference, 

or takes place online. 
2. Address - enter the address of the meeting location. Typically, this includes everything but the City, State 

& Zip code.  If you want the room number to be displayed after the actual address enter it in this field. 
3. Room -  enter the room number if you want it to display before the address. If you prefer to have the room 

number displayed after the address but before the City, State and Zip code, leave this field blank. 
4. City -  Enter the City (often the State and Zip code are also displayed in this field). 
5. Link - You have the option of providing a link related to the location of the meeting. 
6. +location_item - Adds an additional meeting location, video conference location or teleconference access 

information to the meeting block. 
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Remediating Content  

SMART FORM - ADA MEETINGS AND AGENDAS 
“Document Type” Fields 
 
1. Document Type - select whether you are adding an agenda, minutes or other attachments. This 

determines what column the document will appear in. 
2. Document Title -  enter the name of the document you are attaching. Make sure you indicate the date in 

the document title field or another unique identifier or the names will not meet accessibility standards. Each 
name must be unique. 

3. File - Add the file by clicking on the icon in the file selection, then select an existing document or add a new 
document and create the link.  

4. File type - select whether it is a PDF, Word, Excel, Link, Audio File or Video File. 

 

END OF LESSON 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“ADA Documents” Smart Form 
 
1. The information contained within this document guides users on how to use the “ADA Documents” Smart 

Form.  

Note:  If this smart form is used and a template of default.aspx or layouts/full_page.aspx is used, the ADA 

Documents smart form will display in only about two inches of space on the left side of the page and will 

appear more like left navigation than page content.  Be sure to use template layouts/Page_Style_1.aspx 

with this smart form. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
Content Block “Title” Field 
 
1. The first section of the smart form that you will fill out is the content block Title field.  

2. This content block Title will become part of the URL for this “ADA Documents” smart form so the name 

used should be as short as possible.  Spaces and special characters other than an underscore (_) or a 

dash (-) are best avoided. 

3. Once set, if you change this content block “Title” field all links to the "ADA Documents” smart form will 

break. DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Page Title” Field 
 
1. Page Title – This will add a visible level 1 heading to the Documents smart form.  All pages should start 

with a level 1 heading. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Page Copy” area 
 
1. Page Copy – This paragraph field allows you to add text, tables, paragraphs and other information above 

the Category Title and document links associated with the category or page
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Style (choose layout type)” Selection 
 
1. Style – These radio buttons allow you to select from three preset styles.   

2. Style 1 – displays the category title on a brown background and there are lines between the category 

description and document information and the file type icon. 

3. Style 2 – displays the category title on a dark blue background and there are lines between the category 

description and document information and the file type icon. 

4. Style 3 – vertically displays the category title (a level 2 heading) on a white background with a horizontal 

rule directly above the category description, which is directly above the document title which is above the 

document description and file type icon is displayed below that. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Display Index at Top” selection 
 
1. Display Index at top - You can select from “No” if you do not want to display an index. If you want to display 

an index, choose either “Vertical” to display the index vertically or “Horizontal” to display the index 

horizontally. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Documents Category Title and Description” Fields 
 
1. Category Title – This field can be used to include a level 2 heading (title) for a category of documents.  

2. Category Description – This field can be used to include a description of the category of documents. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“Document Title and Description” Fields 
 

1. Document Title – This field will be the title of the document you link to.  

2. Document Date – This can be used to associate a date with a document.   

3. Document Description – This field can be used to describe the document. This will assist users to 

understand what the document is prior to clicking the document link. 
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Remediating Content  

SMART FORM - ADA DOCUMENTS  
“File Type” Field 
 

1. Type Drop-Down Menu – This allows the user to select an icon for the type of document they are 

uploading. Users can choose from: PDF, Word, Excel, Power Point, HTML, Online, Other, Email, Link 

or Do Not Display icon.  

2. File Icon – Adds a link to a document, web page or another website  

3. +File-item – Adds another file to the Document section. 
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Remediating Content  

SMART FORM – ADA LINKS  
“ADA Links” Smart Form 
 

1. The information contained within this document guides users on how to use the “ADA Links” Smart 

Form. 
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Remediating Content  

SMART FORM – ADA LINKS  
Content Block “Title” Field 
 
1. The first section of the smart form that you will fill out is the content block Title field.  

2. This content block Title will become part of the URL for this “ADA Links” smart form so the name used 

should be as short as possible.  Spaces and special characters other than an underscore (_) or a dash (-) 

are best avoided. 

3. Once set, if you change this content block “Title” field all links to the " ADA Links” smart form will break. 

DO NOT CHANGE THIS NAME. 
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Remediating Content  

SMART FORM – ADA LINKS  
“Page Title” Field 

1. Page Title – This field can be added to include a level 1 heading above any the top paragraph 

and any links listed on the page.  Every page should have a level 1 heading. Unlike the content 

block “Title” listed in the previous lesson, the “Page Title” can be changed as many times as you’d 

like as it does not become part of the URL and will NOT break any links to this smart form.  
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Remediating Content  

SMART FORM – ADA LINKS  
“Page Copy” Area 

1. Page Copy – This paragraph field allows you to add text, tables, paragraphs and other 

information above the Category Title and document links associated with the category or page. 
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Remediating Content  

SMART FORM – ADA LINKS  
“Style (choose layout type)” Selections 

1. Style – This configuration selection allows you to select one of 5 distinct styles: Style 1, Style 

2, Style 3, Style 4 or Style 5. 

• Style 1 – displays the page title, page copy area, category title, category description, 

link title, and title description. 

• Style 2 – displays the same thing but the link titles are bulleted. 

• Style 3 - displays the page title, page copy area, category title on a brown background, 

category description, link title, and title description. 

• Style 4 - displays the page title, page copy area, category title on a blue background, 

category description, link title, and title description. 

• Style 5 – displays the page title, page copy area, category title, and link title with bullets. 
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Remediating Content  

SMART FORM – ADA LINKS  
“Category” Selections 

1. Link Category – A level 2 heading for a category of links can be added in this field.   

2. Category Description – If used, this field allows you to describe the category of links listed below 

it.  Be sure the style chosen for the smart form displays this field if you chose to use it. 
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Remediating Content  

SMART FORM – ADA LINKS  
“Link” Fields 

1. Link Title – This field is the label or title of the link and will be what the user clicks on when 

they want to activate the link.  It must be filled out or the link will not be displayed on the page.  

• Absolute Link: http://gov.nv.gov/News-and-Media/Press/2018/Public-Invited-to-The-

Unveiling-of-Governor-Sandoval%E2%80%99s-Official-Portrait/ . Use of absolute links for 

documents or pages within your website can cause the page to load very slowly. 

• Relative Link: /News-and-Media/Press/2018/Public-Invited-to-The-Unveiling-of-Governor-

Sandoval%E2%80%99s-Official-Portrait/   Relative links do not include ‘http://gov.nv.gov’ 

(the main website address) in the link. 

2. Full URL – Enter a relative link if linking to a document or page within your website and enter 

an absolute link if linking to another website.  

3. Simple URL – You can leave this field blank. 

4. Link Description – A description of the link can be added to the “Link Description” paragraph 

section.  Be sure the style chosen for the smart form displays this field if you chose to use it. 

http://gov.nv.gov/News-and-Media/Press/2018/Public-Invited-to-The-Unveiling-of-Governor-Sandoval%E2%80%99s-Official-Portrait/
http://gov.nv.gov/News-and-Media/Press/2018/Public-Invited-to-The-Unveiling-of-Governor-Sandoval%E2%80%99s-Official-Portrait/
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Remediating Content  

SMART FORM – ADA LINKS  
“+link_item and +link_category” Fields 

1. +link_item – This control allows you to add another link item. 

2. +link_category – This control allows you to add another link Category. 
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Remediating Documents  

Document Title 

It is almost always best to remediate the source document rather than waiting to remediate after converting the 

document from Microsoft Word or Excel, etc. to PDF. 

Regardless of the document type, the first thing screen reader users hear is the document title. Blind users cannot 

glance quickly at the content of a web page to see what the page is about, so they rely on the page title to give them this 

information. Web pages without titles waste the time of screen reader users, because they force users to navigate 

through the web page — past the main menu and into the content — to find out what the page is about. 

Most browsers display the page title above the page itself. In tabbed browsers, the title displays in the tab, making it 

easy to identify open pages and to quickly switch between them. The title should be unique, accurate, descriptive, and 

succinct (brief).  Place unique information first. 

Text and Typography 

Font choice is important.  Choose fonts that are easy to read. Avoid fancy fonts, specialty fonts with cursive or unusual 

shapes or artistic feature that may look pretty but are harder to read than standard fonts like Times New Roman or Arial.   

Which are better serif or sans-serif fonts? 

The research is less conclusive as to whether serif fonts (Times New Roman, Georgia) or sans-serif fonts (Arial, Tahoma 

& Verdana) are easier to read. The trend on the web has been toward sans-serif fonts in recent years.   At this point it is 

relatively safe to assume that standard serif and sans-serif fonts are both acceptable. One of the problems with sans-

serif fonts, though, is the possible confusion between upper-case I (as in India) and lower-case L (as in laughter). In most 

circumstances the context provides enough clues to determine which letter it is, but in a few cases, the characters may 

be confused. 

Avoid full-justified blocks of text 

People with certain reading disabilities or cognitive disabilities have problems reading text that is both left and right 

justified. The uneven spacing between words in fully justified text can cause "rivers of white space" to run down the 

page, making reading difficult and, in some cases, impossible. Text justification can also cause words to be either 

bunched closely together or stretched in unnatural ways, so that it is difficult for them to locate word boundaries. 

Break up long passages of text 

Split up long sections of text into separate paragraphs, or lists, or find other ways to make each section of text more 

manageable. 

Don't use color alone to convey information 

Color should not be used as the only visual means of conveying information, indicating an action, prompting a response, 

or distinguishing a visual element. In order to spot where color might be the only visual means of conveying information, 

print the document on a black and white printer and see if there is any missing information. 
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All Important Information (Even References to Colors) Must Exist in a Text Format 

Text is the foundation upon which all other accessible content is built. Everything must exist in a text format — either as 

normal text or as alt text — or else screen readers won't be able to read it. If you color-code anything on a web page, 

you'll need to convey the meaning behind the colors in a text format. 

Avoid Referencing Color, Size, Location, Position, Shape, or Sound in Instructions or Help 
Information 

Any time we reference size, location, position, shape, or sound in information, we're relying on the presence of a specific 

sense (or senses) on the part of our user which they may not have. 

CONTRAST 
The contrast of the text against the background must pass WCAG guidelines 

Ensure color contrast of at least 4.5:1 for small text or 3:1 for large text, even if text is part of an image. Large text has 

been defined in the requirements as 18pts or 14pt bold. 

HEADINGS 

Headings play a vital role in the accessibility level of any document, whether it is a Word, PDF, or HTML document. They 
are used for navigation by screen reader users and they provide a clear structure of a document which benefits all users, 
making it easier to scan through the content. And significantly, in the case of Word documents, properly styled headings 
make it very easy to auto generate a table of contents (TOC) and have noticeably fewer errors when converted to PDF. 

Screen reader users can use keyboard shortcuts to navigate through the heading structure of a document. For example, 
in JAWS, the "H" key jumps from one heading to the next, reading them in sequential order, no matter what level the 
heading is (h1, h2, h3, etc.). The "1" Key jumps through all of the level 1 headings (<h1>). The "2" key jumps through all 
of the level 2 headings (<h2>), and so on. 

Headings are about logical structure, not visual effects. Big bold text may look like a heading to visual users, but screen 

readers ignore the size and font-weight of the text, so blind users cannot know a phrase is a heading unless it is marked 

up in the document's structure (source code) as such. 

REMEDIATING MICROSOFT EXCEL DOCUMENTS 

Alternative Text 
Alternative text should be provided with all visual content: pictures, clip art, SmartArt graphics, shapes, groups, charts, 

embedded objects, ink, and videos. 

1. Right-click a visual content element. 

2. Select “Format Picture,” “Format Shape,” or “Format Chart Area” (depending on the type of visual content)> Size & 

Properties. 

3. Select Alt Text. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT EXCEL DOCUMENTS 

HYPERLINK TEXT 
Those using screen readers can often use their screen readers to look through all of the links in an excel document. The 
links should have descriptive information about the link so that the user knows where they are going.  

1. Right-click a cell. 

2. Select Hyperlink. 

3. In the Text to display box, type the hyperlink text. 

4. In the Address box, enter the destination address for the hyperlink. 

5. Select the ScreenTip button and, in the ScreenTip text box, type a ScreenTip. 
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REMEDIATING MICROSOFT EXCEL DOCUMENTS 
Tab Names 

All worksheet tabs should be appropriately named. Tabs for blank worksheets should be removed.  

Rename sheet tabs 
1. Right-click a sheet tab and select Rename. 

2. Type a brief, unique name for the sheet. 

Delete sheet tabs 
1. Right-click a sheet tab. 

2. Select Delete. 

 

  



Revised 12/18/2018 
 

REMEDIATING MICROSOFT EXCEL DOCUMENTS 
Table Structure 

All worksheet tabs should be appropriately named. 

Tables must be structured and specify column header information.  

Specify a header row in a block of cells marked as a table. 

1. Position the cursor anywhere in a table. 

2. On the Table Tools Design tab, in the Table Style Options group, select the Header Row check box. 

3. Type column headings. 

 

Add headers to a new table 

1. Specify a header row in a new block of cells you are marking as a table. 

2. Select the cells you want to include in the table. 

3. On the Insert tab, in the Tables group, select Table. 

4. Select the My table has headers check box. 

5. Select OK. 

6. Excel creates a header row with the default names Column1, Column2, and so on 

7. Type new, descriptive names for each column in the table. 
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REMEDIATING MICROSOFT EXCEL DOCUMENTS 
Language 

Ensure that the language is set to the desired language for the user.  

1. Click File 

2. Select Options 

3. Select “Language” from the left side of the screen 

4. Click the desired language and then set as default.  

5. The default language will be the language seen by screen readers. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add alt text to images 

Add alt text to images, such as pictures, clip art, and screenshots, so that screen readers can read the text to describe 

the image to users who can’t see the image. 

1. Right-click an image. 

2. Select Format Picture > Layout & Properties. 

3. Select Alt Text. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add alt text to SmartArt graphics 

Add alt text to images, such as pictures, clip art, and screenshots, so that screen readers can read the text to describe 

the image to users who can’t see the image. 

1. Right-click a SmartArt graphic. 

2. Select Format Object > Shape Options > Layout & Properties. 

3. Select Alt Text. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add alt text to shapes 

1. Add alt text to shapes, including shapes within a SmartArt graphic. 

2. Right-click a shape, and then select Format Shape. 

3. In the right pane, select Layout & Properties, and then select Alt Text. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add alt text to charts 

1. Right-click a chart. 

2. Select Format Chart Area > Chart Options > Layout & Properties. 

3. Select Alt Text. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add alt text to tables 

1. Right-click a table. 

2. Select Table Properties. 

3. Select the Alt Text tab. 

4. Type a description and a title. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Add hyperlink text and ScreenTips 

1. Select the text to which you want to add the hyperlink, and then right-click. 

2. Select Hyperlink. The text you selected displays in the Text to display box. This is the hyperlink text. 

3. If necessary, change the hyperlink text. 

4. In the Address box, enter the destination address for the hyperlink. 

5. Select the ScreenTip button and, in the ScreenTip text box, type a ScreenTip. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Apply built-in heading styles 

1. Select the heading text. 

2. On the Home tab, in the Styles group, select a heading style, for example, Heading 1 or Heading 2. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use bulleted lists 

1. Position the cursor anywhere in your document. 

2. Select the Home tab. 

3. In the Paragraph group, select the Bullets button. 

4. Type each bullet item in the bulleted list. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use ordered lists 

1. Position the cursor anywhere in your document. 

2. Select the Home tab. 

3. In the Paragraph group, select the Numbering button. 

4. Type the sequential steps. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use accessible text color 

Here are some ideas to consider: 

Ensure that text displays well by using the Automatic setting for font colors. Select your text, and then select Home > 

Font Color > Automatic. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use accessible text format 

1. Here are some ideas to consider: 

2. Add an underline to color-coded hyperlink text. That can help colorblind people know the text is linked even if they 

can’t see the color. 

3. Add shapes if color is used to indicate status. For example, add a checkmark symbol Excel green check mark if green 

is used to indicate “pass” and an uppercase X of a red box with an uppercase letter X inside the box if red indicates 

“fail”. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use text spacing 

1. Increase or decrease white space between sentences and paragraphs. 

2. Select your text. 

3. Select the Home tab. 

4. In the Paragraph group, in the lower-right corner of the group, select the More button. 

5. The Paragraph dialog box opens, showing the Indents and Spacing tab. 

6. Under Spacing, select the spacing options you want. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use bulleted lists 

1. Position the cursor anywhere in your document. 
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REMEDIATING MICROSOFT Word DOCUMENTS 
Use table headers 

1. Position the cursor anywhere in a table. 

2. On the Table Tools Design tab, in the Table Style Options group, select the Header Row check box. 

3. Type column headings. 
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REMEDIATING PDF DOCUMENTS 
Add a Title to the PDF 

1. Open document properties. 

2. Select description tab. 

3. Insert a document title. 
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REMEDIATING PDF DOCUMENTS 
Change from File Name to Document Title 

1. Select the initial view tab. 

2. Change the file name to document title. 
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REMEDIATING PDF DOCUMENTS 
Language Selection 

1. Select the advanced tab 

2. Set the language to English 
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REMEDIATING PDF DOCUMENTS 
Start Accessibility Checker in Acrobat 

1. Select the tools option and it will open up the tools menu. 

2. Select the full check accessibility.  

3. Select "Start Checking" 
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REMEDIATING PDF DOCUMENTS 
Add Alternative Text to Images 

1. Use the touch up reading order option in the tools panel. 

2. Highlight the image and select it as a figure. 

3. Right click on figure and select the edit alternate text option. 

4. Enter the image description in the alternate text box. 

 

  



Revised 12/18/2018 
 

REMEDIATING PDF DOCUMENTS 
Select the Reading Order 

1. Select the order tab in the left panel to verify the reading order of the document. 

2. Move the order so it is read left to right in order and it would be in a book. 
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REMEDIATING PDF DOCUMENTS 
Re-run the Accessibility Check 

1. Re-run the full check of the document after the corrections have been made to verify that the changes have taken 

place and new errors have not been created. 
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REMEDIATING PDF DOCUMENTS 
Re-run the Accessibility Check 

1. Re-run the full check of the document after the corrections have been made to verify that the changes have taken 

place and new errors have not been created. 

 

CONGRATULATIONS – END OF LESSON 
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Frequently Asked Questions 

ALTERNATIVE TEXT - WHY DO I NEED TO ADD ALTERNATIVE TEXT TO IMAGES ON MY SITE? 

Images must have text alternatives that describe the information or function represented by them. This ensures that 

images can be used by people with various disabilities. 

Source - https://www.w3.org/WAI/tutorials/images/  

COLORS - WHY AM I REQUIRED TO USE ONLY CERTAIN COLORS OF TEXT? 

Certain people with disabilities as well as many other people without documented disabilities have difficulty seeing 

certain colors, especially when text is too close to the background color of the text. We limit the colors that can be used 

because it is important to have easy to see colors that contrast well with each other. 

DOCUMENTS - DO DOCUMENTS POSTED TO THE WEBSITE NEED TO BE ADA COMPLIANT? 

Yes. Documents, spreadsheets, presentations, PDFs and any other "documents" that you add to the website need to be 

ADA compliant. We have provided training resources here:  

http://ada.nv.gov/Compliance/Accessible-Documents/  

http://ada.nv.gov/Compliance/Accessible-PDFs/  

WEBSITE ACCESSIBILITY - WHY IS WEBSITE ACCESSIBILITY IMPORTANT? 

Web Accessibility is important to ensure that as many people as possible can access the State of Nevada's online 

resources and services as possible. Another important reason for designing State of Nevada websites with accessibility in 

mind is that the United States Department of Justice can enforce website accessibility standards on lower levels of 

government if they accept Federal funds. 

https://www.w3.org/WAI/tutorials/images/
http://ada.nv.gov/Compliance/Accessible-Documents/
http://ada.nv.gov/Compliance/Accessible-PDFs/
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